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Рассмотрено на заседании предметной цикловой комиссии 

общепрофессиональных, специальных дисциплин и дипломного 

проектирования по специальностям 08.02.01 Строительство и 

эксплуатация зданий и сооружений, 08.02.07 Монтаж и эксплуатация 

внутренних сантехнических устройств, кондиционирования воздуха и 

вентиляции, 43.02.08 Сервис домашнего и коммунального хозяйства. 

Данные методические указания предназначены для студентов 
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обучения студентов работе в программе 3-х мерной графики 3D 

STUDIO MAX при выполнении практических работ по дисциплине 

ОП.14. Компьютерная графика и 3d-моделирование при изучении темы 

«Программа 3-х мерной графики 3D STUDIO MAX». 

Указания включают в себя краткий теоретический и 

практический материал, позволяющий получить представление о 

работе в 3D STUDIO MAX. Представленный материал позволяет на 

конкретных примерах изучить основные возможности применения 

различных инструментов 3D STUDIO MAX. 

 

Авторы: С.В.Норинова, преподаватель 
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ОСНОВНЫЕ СВЕДЕНИЯ 

3D Studio Max – наиболее распространенное в мире 

программное обеспечение для 3D моделирования, анимации и 

визуализации, включающее в себя многочисленные инструменты для 

моделирования трехмерных сцен. Широкие возможности, заложенные 

в 3D Studio Max, позволяют успешно работать пользователям с разным 

уровнем подготовки. Материал, изложенный в методических 

указаниях, поможет быстро освоить основные методики 

моделирования сложных поверхностей. 

Для того чтобы начать работать в пакете 3D Studio Max, 

необходимо запустить Autodesk 3ds Max. Когда запустится система 3D 

Studio Max, на экране появится диалоговое окно  

 
 

Интерфейс пакета Autodesk 3D Studio Max  

 Вдоль верхнего края окна 3ds Max расположено главное меню, 

методы работы с которым типичны для приложений Windows.  
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В таблице перечислены основные функции главного меню 

среды 3ds Max: 

 
Чуть ниже главного меню расположена панель инструментов 

 
Пакет 3ds Max имеет достаточно сложный интерфейс. Все 

многочисленные функции разделены на группы и свитки. Например, в 

командной панели  
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находится набор инструментов для создания и редактирования 

объектов, а также для настроек параметров анимации среды 3ds Max. 

 
Так же есть Панель инструментов 

 
, 

шкала анимации 



6 
 

, 

 координатные поля  

 
и кнопки управления анимацией 

. 

В отличие от стандартных панелей инструментов Windows, 

панели инструментов 3ds Max можно прокручивать, если они выходят 

за пределы экрана. 

Ниже показано типичное размещение окон проекций, которые 

позволяют рассмотреть трехмерный объект под различным углом 

зрения. Для активизации окна проекции щелкните правой кнопкой 

мыши в неактивном окне проекции, имеющем черную рамку, окно 

проекции при этом станет активным, а его рамка – желтой. В левом 

верхнем углу находится заголовок окна проекции. В каждом окне 

проекции трехмерная сцена может отображаться, например, в одной из 

следующих проекций: Front – вид спереди; Back – вид сзади; Left – вид 

слева; Right – вид справа; Top – вид сверху; Bottom – вид снизу и т.д. 
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В среде 3ds Max можно видеть сцену с четырех направлений, 

назначив разные виды каждому окну проекции. 

 

ТИПЫ ОБЪЕКТОВ 

Объекты в 3ds max можно разделить на несколько категорий:  

1. Geometry (Геометрия); 

2. Shapes (Формы); 

3. Lights (Источники света); 

4. Cameras (Камеры); 

5. Helpers (Вспомогательные объекты); 

6. Space Warps (Объемные деформации); 

7. Systems (Дополнительные инструменты). 
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СОЗДАНИЕ ОБЪЕКТОВ 

Объекты в 3ds max создаются при помощи команд пункта главного 

меню Create (Создание) или одноименной вкладки командной панели. 

Чаще используется второй способ, так как он является более удобным.  

Чтобы создать объект, сделайте следующее.  

1. Перейдите на вкладку Create (Создание) командной панели.  

2. Выберите категорию, в которой находится нужный объект, для 

примитивов это категория Geometry (Геометрия).  

3. Из раскрывающегося списка выберите группу, в которой находится 

нужный объект. Для простых примитивов — это группа Standard 

Primitives (Простые примитивы).  

4. Нажмите кнопку с названием объекта. 

5. Щелкните в любом месте окна проекции и, не отпуская кнопку, 

передвигайте указатель мыши до тех пор, пока не измените размер 

объекта до нужного.  

ВЫДЕЛЕНИЕ ОБЪЕКТОВ 

В 3ds max существует несколько способов выделения объектов. Самый 

простой — щелчок на объекте инструментом Select Object (Выделение 

объекта), который расположен на основной панели инструментов. Если 

вы находитесь в режиме отображения объектов Wireframe (Каркас), 

объект станет белым.  
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В режиме Smooth+Higlights (Сглаженный) вокруг выделенного объекта 

появятся квадратные скобки белого цвета 

 

Для выделения более чем одного объекта можно использовать клавишу 

Ctrl. Удерживая ее, щелкайте на объектах, которые вы желаете 

выделить. Чтобы убрать объект из числа выделенных, удерживая 

клавишу Alt, щелкните на объекте, с которого вы желаете снять 

выделение. 

СОЗДАНИЕ ПРОСТЫХ ОБЪЕКТОВ 

Сначала научимся управлять единицами измерения — основой 

правильного определения расстояний и размеров. Выбор единиц 

измерения определяет цену деления измерительной шкалы, в них будут 

отображаться объекты созданной сцены. 

Выберите команду меню Customize > Units Setup (Настроить > 

Настройка единиц измерения), чтобы открыть окно настройки системы 

единиц измерения, и установите тип единиц 

измерения Metric (Метрическая). Из раскрывающегося списка, 
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содержащего 

варианты Millimeters (Миллиметры), Centimeters (Сантиметры), Meters

 (Метры) и Kilometers (Километры), выберите Centimeters. Сделанный 

выбор отражается в поле отсчета координат в строке состояния путем 

добавления к значению координат единицы измерения «cm«. 

Теперь установите системные единицы измерения, которые повлияют 

на размеры сетки на экране. Для этого в том же окне нажмите на 

кнопку System Unit Setup (Установка системных единиц) и в 

разделе System Unit Scale (Масштаб системной единицы) также 

установите Centimeters (Сантиметры). 

Для дальнейшей работы настроим параметры сетки в видовых 

окнах. Для этого включите вид с четырьмя равными по величине 

окнами, во всех окнах включите сетку (правой кнопкой мыши 

щелкните на названии окна, и в контекстном меню установите флажок 

на Show Grid – рис. 1.2; можно иначе – щелкнуть по клавише «G» на 

клавиатуре компьютера). 

 
Рис. 1.2 

Затем на основной панели инструментов щелкните правой 

кнопкой мыши по команде Snaps Toggle (Переключатель объектных 

привязок) , чтобы открыть окно Grid and Snap Settings (Настройка 

параметров сетки и объектной привязки), перейдите на вкладку Home 

Grid(Координатная сетка) и в поле Grid Spacing (Расстояние между 

линиями сетки) укажите величину 10,0cм. Тогда шаг основной сетки, 

отображаемой в видовых окнах, будет равен 10,0 см. В окошке Major 

Lines every Nth Grid Line (Основные линии через каждые N линий 

http://3dtuts.by/wp-content/uploads/2010/06/max1.2.jpg
http://3dtuts.by/wp-content/uploads/2010/06/Snaps_Toggle.gif
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сетки) выставьте величину 5. Тогда между основными линиями сетки 

будут размещены пять делений сетки (рис. 1.3). Закройте это окно. 

 
Рис. 1.3 

Теперь настроим параметры отображения моделей объектов для 

более удобного предварительного просмотра визуализируемой сцены. 

Для этого щелкните правой кнопкой мыши на названии видового окна 

и в раскрывшемся списке команд выберите 

команду Configure(Конфигурация). Раскроется диалоговое 

окно Viewport Configuration (Конфигурация видового окна). В 

появившемся окне выберите вкладкуRendering Method (Метод 

визуализации) и в разделе Rendering Options (Параметры визуализации) 

установите флажок напротив Texture Correction (Коррекция текстуры) 

для более точного отображения текстур на объектах, Force 2-

Sided (Показать обе стороны) для показа внутренней стороны 

объекта, Default Lighting (Освещение по умолчанию) для 

использования встроенного освещения в сцене вместе с 

установленными источниками света. Расположенный ниже 

переключатель установите в положение 2 Lights (2 источника света). 

http://3dtuts.by/wp-content/uploads/2010/06/max1.3.gif
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По умолчанию в сцене без внешнего освещения используется один 

встроенный источник освещения, но с двумя сцена смотрится более 

яркой. Для других параметров можно оставить значения по умолчанию. 

Сохраните файл, присвоив ему имя Index.max. Теперь у вас есть файл с 

настройками, и создание каждой новой сцены удобно начинать с 

открытия этого файла. 

Научимся устанавливать привязки. Привязки позволяют 

размещать опорные точки создаваемых или редактируемых объектов в 

точно определенных местах. Средства привязки заставляют курсор 

«притягиваться» к определенным точкам объектов сцены, таким как 

вершины, ребра, центры граней или точки опоры, а также, что наиболее 

привычно, к линиям или узлам исходной сетки или конструкционной 

плоскости. Кроме того, привязки позволяют задать фиксированные 

величины приращений параметров при вращении или 

масштабировании объектов, а также приращений параметров в 

числовых полях при использовании счетчиков. 

Выберите команду меню Tools > Grids and Snaps > Grid and Snap 

Settings (Инструменты > Сетки и объектные привязки > Настройки 

сетки и объектных привязок). Появится окно диалога Grid and Snap 

Settings (Настройки сетки и объектных привязок), раскрытое по 

умолчанию на вкладке Snaps (Объектные привязки). Оставьте галочку 

только в окошке Grid Points(Узлы сетки). Однако пока привязка не 

будет действовать. Чтобы ее активизировать, необходимо на основной 

панели инструментов выбрать соответствующий тип привязки. 

Выберем 3D Snaps Toggle (Переключатель объектных привязок) . 

Попробуйте теперь создать, например, Box (Параллелепипед). 

Обратите внимание, что курсор приобрел форму прямоугольника с 

перекрестьем в виде прямых по осям . Этот прямоугольник как бы 

http://3dtuts.by/wp-content/uploads/2010/max/Index.max
http://3dtuts.by/wp-content/uploads/2010/06/Snaps_Toggle.gif
http://3dtuts.by/wp-content/uploads/2010/06/Coursor_Snap.gif
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«прилипает» к узлам сетки. Для тренировки создайте 3 

параллелепипеда со сторонами 20, 30 и 40 см. 

А сейчас, чтобы очистить результаты ваших экспериментов, 

выполните из верхнего меню команду File > Reset (Файл > Сброс). 

Скажите No на запрос о сохранении файла и Yes на запрос о сбросе. 

Сейчас мы создадим простую елочку. Создадим ее из двух 

стандартных примитивов — ствол из цилиндра (Cylinder) и крону из 

конуса (Cone). Обратите внимание, чтобы елка была реального 

размера, тем более что у нас включены сейчас сантиметры. Пусть она 

будет 2-3 м высотой. Чтобы уточнить размеры этих примитивов, 

откройте вкладку Modify (Изменить)  в командной панели 

инструментов и внесите нужные изменения. Для размещения конуса 

над цилиндром воспользуйтесь командой Select and Move (Выделить и 

перенести) . Примените подходящие цвета и сгруппируйте два 

примитива. Для этого выделите оба примитива и далее из верхнего 

меню выполните Group > Group (Группа > Группировать). Группе надо 

дать имя, например Elm. Должно выйти аналогично тому, что вы 

видите на рис. 1.4. 

 
Рис. 1.4 

Из получившейся «елочки» создадим аллею. Выделим «елку» и на 

основной панели инструментов выберем Tools > Array (Инструменты > Массив). 

В разделе Array Dimensions (Размерность массива) отметим 

вариант 1D (Одномерный массив) и число Count (Количество) зададим равным 5, 

а в верхней части окна в разделе Incremental (Расстояние между объектами) 

установим смещение по оси Х, например 150 см, так, как на рис. 1.5. У вас 

получится небольшая аллея. 

http://3dtuts.by/wp-content/uploads/2010/06/Modify.gif
http://3dtuts.by/wp-content/uploads/2010/06/Select_and_Move.gif
http://3dtuts.by/wp-content/uploads/2010/06/max1.4.jpg
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Рис. 1.5 

Теперь создадим двумерный массив из «лиственных деревьев». 

Рядом с «елкой» установим «дерево», сделанное из примитивов: ствол 

из объекта Cylinder (Цилиндр), а крону из объекта Oil Tank (Бак), 

входящего в семейство объектов Extended Primitives (Дополнительные 

примитивы), сгруппируйте объект (рис. 1.6). 

 
Рис. 1.6 

 
Рис. 1.7 

Оставьте дерево выделенным. Потом снова выберите в верхнем меню Tools > 

Array (Инструменты > Массив). Задайте Array Dimensions — 2D (Двумерный массив) 

и смещение по оси Х (в разделе Incremental – Расстояние между объектами) установите 

равным 150 см, числоCount (Количество) для 1D – 5, для 2D — тоже 5. Смещение по 

оси Y установите «-150» см, но указать это надо уже в нижней части окна, так, как на 

рис. 1.7. 

 

http://3dtuts.by/wp-content/uploads/2010/06/max1.5.gif
http://3dtuts.by/wp-content/uploads/2010/06/max1.6.gif
http://3dtuts.by/wp-content/uploads/2010/06/max1.7.gif
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Осталось подложить под это основание. Сделаем его из простого 

примитива Box (Параллелепипед) зеленого цвета. Должно выйти 

примерно так, как изображено 

на рисунке: 

 

 

 

 

 

 

 

 

ОСНОВНЫЕ КОМАНДЫ 

Откройте файл Reconstruct_the_wall.max. Начальная картинка сейчас 

выглядит так, как показано на рис. 2.1. Ваша задача – вернуть кирпичи 

на место в стену. Для этого вам достаточно двух основных 

кнопок Select and Move (Выделить и перенести)  и Select and 

Rotate (Выделить и повернуть) , расположенных на основной 

панели инструментов. Разворачивайте кирпичи так, чтобы они были 

параллельны стенам, и вставляйте их в неё. 

 
Рис. 2.1 

http://3dtuts.by/wp-content/uploads/2010/max/Reconstruct_the_wall.max
http://3dtuts.by/wp-content/uploads/2010/06/Select_and_Move.gif
http://3dtuts.by/wp-content/uploads/2010/06/Select_and_Rotate.gif
http://3dtuts.by/wp-content/uploads/2010/06/max2.1.jpg
http://3dtuts.by/wp-content/uploads/2010/06/max1.8.jpg
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Чтобы убедиться, что кирпич попал на место, можно вращать окно 

перспективы (остальные трогать не рекомендуется), нажав 

предварительно кнопку . Должно получиться примерно так, как на 

рис. 2.2. 

 
Рис. 2.2 

2.  Другой способ. Для этого начните все сначала, предварительно 

выполнив команду File > Reset (Файл > Сброс). Как только вы выделите 

какой-нибудь кирпич, при включенной кнопке Select and 

Rotate (Выделить и повернуть) , в строке состояния (рис. 2.3) (эта 

строка внизу) отобразится угол его разворота относительно осей 

координат – можно просто вводить нужные вам углы – кирпичи будут 

вертеться сами. Аналогично, но уже при нажатой кнопке Select and 

Move (Выделить и перенести) , вводя координаты в строке 

состояния (рис. 2.3), можно не только вращать, но и перемещать 

объекты. 

 
Рис. 2.3 

3. Третий способ, и снова начните все сначала. Можно также 

воспользоваться командой Align (Выровнять) , которая позволяет 

выровнять один объект относительно другого. Предварительно следует 

выделить отдельный кирпич, а затем обратиться к этой команде, 

расположенной на основной панели инструментов ( ), или 

выполнить команду Tools > Align (Инструменты > Выровнять). После 

http://3dtuts.by/wp-content/uploads/2010/06/Arc_Rotate.gif
http://3dtuts.by/wp-content/uploads/2010/06/max2.2.gif
http://3dtuts.by/wp-content/uploads/2010/06/max2.3.gif
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этого щелкните на том кирпиче в стене, параллельно которому следует 

расположить новый кирпич. Появится диалоговое окно Align Selection 

(Выровнять положение выделенных объектов), в котором следует 

сбросить все флажки в области Align Position (Выровнять положение 

координат) и установить все флажки в области Align 

Orientation(Выровнять ориентацию). Тем самым вы выровняете 

взаимную ориентацию объектов. 

4. Чтобы вставить кирпич в нужное место, можно также 

воспользоваться инструментом Snaps Toggle (Переключатель 

объектных привязок) , расположенным на основной панели 

инструментов. Вначале следует щелкнуть правой кнопкой мыши на 

этом инструменте и в появившемся диалоговом окне сбросить все 

флажки, за исключением одного – Vertex(Вершина). Этим вы зададите 

привязку к вершинам объектов. Теперь активизируйте команды Select 

and Move (Выделить и перенести)  и Snaps Toggle (Переключатель 

объектных привязок) (вариант 3D) , подведите курсор мыши к 

одной из вершин кирпича и перетащите его в нужное место. Кирпич 

сам займет необходимое положение. Поэкспериментируйте с 

различными способами перемещения кирпичей. 

5. Если вы успешно выполнили это упражнение, то для закрепления 

навыков следует выполнить еще одно: собрать спички в коробок. Для 

его выполнения откройте файл Matches.max. Спички можно собирать в 

коробок, не открывая его. Для выполнения этой задачи достаточно 

воспользоваться теми же командами. Разворачивайте спички, чтобы 

они были параллельны коробку, и перетаскивайте их в коробок. 

  

http://3dtuts.by/wp-content/uploads/2010/max/Matches.max
http://3dtuts.by/wp-content/uploads/2010/06/Snaps_Toggle.gif
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СОЗДАНИЕ КОНСТРУКЦИЙ ИЗ ПРИМИТИВОВ, РЕНДЕРИНГ 

Задание 1 

1. Цель данного занятия — продолжение работы со стандартными 

примитивами. Это основа для получения остальных навыков. В 

процессе изучения мы будем создавать небольшую колоннаду. Хотим 

получить примерно то, что вы можете увидеть в конце этого задания. 

2. В блоке командных панелей (в правой части экрана) в 

закладке Create (Создать) в пункте Geometry (Геометрия) в 

выпадающем списке находим Standard Primitives (Стандартные 

примитивы) — этот путь открывается по умолчанию при первом 

запуске 3ds Max. Откроется меню стандартных примитивов, 

показанное на рис. 3.1. Стандартными примитивами 3ds Max 

практически всех версий 

являются  Box  (Параллелепипед),  Cone  (Конус), Sphere (Сфера), Geo

Sphere (Геосфера),Cylinder (Цилиндр), Tube (Труба), Torus (Тор), Pyra

mid (Пирамида), Teapot (Чайник) и Plane (Плоскость). 

 
Рис. 3.1 

http://3dtuts.by/wp-content/uploads/2010/06/max3.1.jpg
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3. Откройте файл Index.max с готовыми настройками. Сначала 

создадим основание колоннады. Для этого в закладке Create (Создать) 

в пункте Geometry (Геометрия) в разделе Standard 

Primitives (Стандартные примитивы) выбираем 

инструмент Box (Параллелепипед). На виде Top (Вид сверху) 

очерчиваем площадь основания, перемещаем мышь на вид Front (Вид 

спереди) или Left (Вид слева) и показываем высоту основания. Если 

сразу не попали в желаемый размер, изменить его можно, выделив 

инструмент Select and Uniform Scale (Выделить и равномерно 

масштабировать) , выделив уже размещенное основание и 

перемещая мышь с прижатой левой кнопкой вверх-вниз. 

Еще более точно задать размеры можно, переключившись в 

закладку Modify (Изменить)   (в правом блоке командной панели) и 

просто написать длину, ширину и высоту (рис. 3.2). 

 
Рис. 3.2 

4. Создадим колонну: Create > Geometry > Standard Primitives > 

Cylinder (Создать > Геометрия > Стандартные примитивы > Цилиндр). 

На виде Top(Вид сверху) проектируем колонну. 

Теперь попробуйте применить инструмент Cylinder (Цилиндр) на 

других видах (Left и Front). Колонны будут получаться «не в том 

направлении». Чтобы удалить «неправильные» колонны, можно их 

выделить, например кнопкой Select Object (Выделить объект) , и 

нажать клавишу Delete (Удалить). 

Теперь необходимо создать «копии» первой колонны. Для этого 

первую колонну выделим кнопкой Select and Move (Выделить и 

http://3dtuts.by/wp-content/uploads/2010/max/Index.max
http://3dtuts.by/wp-content/uploads/2010/06/Select_and_Uniform_Scale.gif
http://3dtuts.by/wp-content/uploads/2010/06/Modify.gif
http://3dtuts.by/wp-content/uploads/2010/06/max3.2.gif
http://3dtuts.by/wp-content/uploads/2010/06/Select_Object.gif
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перенести) , выделим ось, в направление которой нужно двигать 

колонну, прижмем клавишу Shift, нажмем левую кнопку и с ее 

помощью протянем колонну в нужном направлении. Появится меню, 

показанное на рис. 3.3. Кружочек оставьте в положении Copy (Копия), 

а в поле Number of Copies (Количество копий) введите 3. 

 
Рис. 3.3 

5. Если вы все сделали верно, у вас сейчас уже есть 4 колонны. 

Осталось только их «подровнять» относительно основания колоннады. 

Для этого вначале выделите все колонны и сгруппируйте их в одну 

группу (Group > Group). Затем выделите эту группу, щелкните на 

кнопке Align(Выровнять) , а потом на основании колоннады. В 

появившемся диалоговом окне отметьте X Position (По координате Х) 

и Y Position (По координате Y). Остальные флажки снимите. 

Поднимите колонны на высоту основания. 

6. Теперь создаем «крышу» колоннады. Для этого выберем Create > 

Geometry > Standard Primitives > Pyramid. Также работаем на виде Top, 

задавая в нем площадь, а затем перемещением мыши вверх и вниз 

http://3dtuts.by/wp-content/uploads/2010/06/Select_and_Move.gif
http://3dtuts.by/wp-content/uploads/2010/06/max3.3.gif
http://3dtuts.by/wp-content/uploads/2010/06/Align.gif
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высоту. Пока «крыша» будет на земле, т.е. получится что-то наподобие 

рис. 3.4. 

 
Рис. 3.4 

Инструментом Select and Move (Выделить и перенести) «поднимем 

крышу» на нужную высоту. 

7. Остается теперь все аккуратно «подровнять», используя координаты 

в строке состояния. У вас должно выйти что-то наподобие рис. 3.5. 

 
Рис. 3.5 

 

Задание 2 

1. В данном упражнении мы продолжим работу с примитивами и будем 

создавать маленький «Храм Артемиды», который можно увидеть в 

http://3dtuts.by/wp-content/uploads/2010/06/max3.4.jpg
http://3dtuts.by/wp-content/uploads/2010/06/max3.5.jpg
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конце этого задания. 

 

2. Откройте файл Index.max с готовыми настройками единиц 

измерения. Сначала создайте основание будущей колонны. Для этого 

воспользуемся примитивом Create > Standard Primitives > Cone (Создать 

> Стандартные примитивы > Конус). На виде сверху изображаем 

основание конуса, потом выполняем щелчок мыши и показываем 

высоту конуса, потом щелчок и, перемещая указатель мыши вниз, 

выбираем верхний радиус. У вас получится примерно, как на рис. 4.1. 

 
Рис. 4.1 

3. Теперь зададим конусу точные размеры и точные координаты в 

пространстве. Для этого перейдите на вкладку Modify (Изменить)  и 

введите: нижний радиус Radius 1 = 60, верхний радиус Radius 2 = 30 и 

высота Height = 40 (рис. 4.2). Помимо этого, поместите основание 

первой колонны в начало координат, в точку X = Y = Z = 0. Чтобы 

сделать это, выберите команду Select and Move (Выделить и 

перенести)  и в строке состояния укажите все координаты равными 

0. Если все изображение исчезло с экрана, то щелкните на кнопке Zoom 

Extents All (Масштабировать все окна до заполнения)  (справа 

внизу). 

 
Рис. 4.2 

http://3dtuts.by/wp-content/uploads/2010/max/Index.max
http://3dtuts.by/wp-content/uploads/2010/06/max4.1.jpg
http://3dtuts.by/wp-content/uploads/2010/06/Modify.gif
http://3dtuts.by/wp-content/uploads/2010/06/Select_and_Move.gif
http://3dtuts.by/wp-content/uploads/2010/06/Zoom_Extents_All.gif
http://3dtuts.by/wp-content/uploads/2010/06/max4.2.gif
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4. Измените цвет конуса на более «подходящий». Для этого на 

вкладке Modify (Изменить) щелкните по кнопке выбора цвета и 

выберите понравившийся (рис. 4.3). 

 
Рис. 4.3 

5. Теперь на основание «возведем» саму колонну. Для этого 

воспользуйтесь стандартным примитивом Cylinder (Цилиндр). Затем 

задайте цилиндру точные размеры: Radius = 30 (равен параметру Radius 

2 у основания), высота Height = 260 (чтобы вместе с высотой основания 

получилось 260 + 40 = 300). 

Колонну надо поставить на основание. Для этого опять воспользуйтесь 

инструментом Select and Move (Выделить и перенести) , и в строке 

состояния введите координаты X = Y = 0, Z = 40 (высота основания). 

Цвет колонны также измените, чтобы он совпадал с цветом основания. 

6. Для удобства дальнейшей работы сгруппируйте основание с 

колонной. Для этого выделите конус и цилиндр (с прижатой клавишей 

<Ctrl>) и в верхнем меню в пункте Group (Группа) 

выполните Group (Группировать), после чего введите имя группы, 

например Column. Но для того чтобы таких колонн было три, создайте 

«копии» первой колонны — клоны. Для этого на виде Front (Вид 

спереди) выделите первую колонну и с нажатой клавишей 

<Shift> переместите «клон» в новые координаты. Повторите это 

дважды. Если дважды повторять не хочется, то в возникающем 

контекстном меню в окне Number of Copies (Количество копий) 

введите 2. Одну «новую» колонну переместите в координату X= — 200, 

http://3dtuts.by/wp-content/uploads/2010/06/max4.3.gif


24 
 

другую в X = 200. Обратите внимание, что координата Z для всей 

группы стала равна 150 — центр от высоты 300. 

7. Теперь сгруппируйте все три колонны и назовите новую группу, 

например 3_Columns. Далее на виде Left (Вид слева) методом 

клонирования сместите эту группу вправо и создайте еще 4 клона. Не 

забывайте, что шаг между колоннами мы установили равным 200. 

Исходя из данного шага, откорректируйте положение новых групп. 

Разгруппируйте три промежуточные группы. Для этого выделите 

соответствующую группу, а затем выполните Group > Ungroup (Группа 

> Разгруппировать) и удалите из них внутренние колонны. На 

виде Top (Вид сверху) у вас должно получиться то, что вы видите на 

рис. 4.4. 

 
Рис. 4.4 

8. Из стандартного примитива Box (Параллелепипед) на виде Top (Вид 

сверху) создадим основание для «храма». Чтобы оно смотрелось 

гармонично, рекомендуется установить его с длиной Length = 

960, шириной Width = 560 и высотой Height = 40. Координаты X = 0, 

Y= — 400 (это центр сооружения), Z = — 40 (равна высоте основания 

со знаком минус). Цвет основания тоже поменяйте. 

9. Путем клонирования основания и перемещением клона на 

виде Left (Вид слева) создайте верхнюю часть храма. У нее 

http://3dtuts.by/wp-content/uploads/2010/06/max4.4.gif
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относительно нижней будет изменена только координата Z = 300 

(высота колонн). Теперь мы получили то, что вы видите на рис. 4.5. 

 
Рис. 4.5 

10. Осталось сделать «крышу». Мы пока ограничимся простым 

вариантом и на виде Top (Вид сверху) создадим крышу из 

примитива Pyramid (Пирамида). Установите для нее шириру Width = 

600, ширину в другом направлении Depth = 1000 и высотуHeight = 100. 

Координаты также рассчитать нетрудно: X = 0, Y = — 400 (опять 

центр), Z = 340 (колонны + верхняя часть). Цвет для крыши подберите 

красноватый или зеленоватый (рис. 4.6). 

 
Рис. 4.6 

11. Так как вы уже создали храм, то необходимо научиться более 

качественно управлять вариантами просмотра в видовых окнах. Во-

первых, стандартный вид в 4-х окнах (Сверху — Top, Спереди 

— Front, Слева — Left, Перспектива — Perspective) не догма, и в любом 

http://3dtuts.by/wp-content/uploads/2010/06/max4.5.gif
http://3dtuts.by/wp-content/uploads/2010/06/max4.6.jpg
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из четырех окон вы можете отобразить любую из проекций. Кроме 

того, в каждом из окон можно выбрать, как будет отображаться 

проекция в окне. Для этого нажмите правую кнопку мыши на названии 

окна, например Top (Вид сверху), и в появившемся контекстном меню 

(его вы видите на рис. 4.7) можно выбрать Smooth + 

Highlights (Гладкость + Освещенность) или Wireframe (Каркасная 

модель). Можно также включить или выключить сетку (Show Grid). В 

данном меню еще много прочих возможностей, в частности 

через Configure > Layout (Кофигурация > Планировка) можно поменять 

вид окон от привычных четырех равного размера на 2 или 4, но 

разномасштабных. Попробуйте на вашем проекте. 

 
Рис. 4.7 

12. Предположим, что теперь вы решили распечатать вид на принтере 

или использовать его для дальнейшей обработки. Для этого 

предназначен Rendering (Визуализация), когда объемная модель 

отображается на плоской картинке. Реально в каждой из проекций вы 

http://3dtuts.by/wp-content/uploads/2010/06/max4.7.gif
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видите рендеринг. Но когда нужно создать готовый графический файл, 

действуем так (реальные возможности рендеринга будут рассмотрены 

позднее, поэтому пока самое простое): 

выберем вид Perspective (Перспектива) и красиво позиционируем 

здание; 

в верхнем меню выберем Rendering > Environment (Визуализация > 

Внешняя среда); в появившемся окне в области Background (Фон) 

щелкните на Color (Цвет). Измените цвет фона, на котором будет 

выводиться картинка, и выберите понравившийся (изменяется плавно 

перемещением крестика и ползунка справа, рис.  4.8); 

 
Рис. 4.8 

закройте это окно и снова нажмите Rendering > 

Render Setup (Визуализация > Параметры визуализатора). В 

появившемся окне в разделе Output Size (Размер изображения) 

выберите размер будущего изображения (например, 640×480) и 

снова Render(Визуализировать) (внизу справа). 

Картинка готова. В верхнем меню в окне с финальной картинкой 

нажмите на иконку с дискетой, и можете сохранить изображение в 

любом из предложенных форматов (gif, jpeg, bmp и многие другие). Для 

пересылки через Интернет и просто для удобства хранения 

рекомендуются gif или jpeg. 

http://3dtuts.by/wp-content/uploads/2010/06/max4.8.jpg
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СПЛАЙНЫ, ТЕЛА ВРАЩЕНИЯ 

1. Для начала основные определения. Все формы в 3ds Max создаются 

из трех основных подобъектов: 

Vertex (Вершина). Безразмерная точка в пространстве; 

Segment (Сегмент). Связующая линия между двумя вершинами; 

Spline (Сплайн). Открытый (разомкнутый) или закрытый (замкнутый) 

набор вершин и сегментов. 

2. Научимся создавать простейшие сплайны. Щелкните на 

кнопке Shapes (Формы) командной панели Create (Создать) и выберите 

в раскрывающемся списке разновидность объектов Splines (Сплайны). 

В свитке Shapes (Формы), показанном на рисунке рис. 7.1, появятся 

кнопки с надписями, соответствующими типам стандартных сплайнов. 

 
Рис. 7.1 

Всего в cвитке Object Type (Тип объекта) имеются инструменты для 

создания следующих десяти стандартных 

сплайнов: Line (Линия),Rectangle (Прямоугольник), Circle (Окружност

ь), Ellipse (Эллипс), Arc (Дуга), Donut (Кольцо), NGon (N-

угольник), Star (Звезда), Text (Текст),Helix (Спираль). 

Воспользовавшись этими стандартными инструментами, выполните 

упражнение, показанное на рис. 7.2.  

http://3dtuts.by/wp-content/uploads/2010/06/max7.1.gif
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Рис. 7.2 

3. Если вы сейчас проведете визуализацию (Rendering > 

Render (Визуализация > Получить изображение)), то получите пустую 

картинку. Это связано с тем, что сплайны по умолчанию не 

визуализируются. Чтобы сплайн стал видимым на конечном 

изображении, выделите его, перейдите в Modify (Изменить)  и в 

свитке Rendering (Визуализация) поставьте галочку в Enable In 

Renderer (Сделать видимым на изображении). Повторите 

визуализацию. Сплайн появился. Сделайте визуализируемыми все 

сплайны в вашей сцене. 

Однако сейчас все сплайны одной толщины. Чтобы ее изменить, 

выделите сплайн, перейдите в Modify (Изменить)  и в той же 

закладке Rendering (Визуализация) измените толщину в 

окошке . Поставьте для всех сплайнов в сцене 

разную толщину от 1 до 10 см. В видовых окнах толщина не 

изменилась, но не удивляйтесь, все так и должно быть. Проведите 

визуализацию и убедитесь, что толщина реально изменилась. 

http://3dtuts.by/wp-content/uploads/2010/06/max7.2.gif
http://3dtuts.by/wp-content/uploads/2010/06/Modify.gif
http://3dtuts.by/wp-content/uploads/2010/06/Thickness.gif
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Чтобы изменить толщину линий и в видовых окнах, на 

панели Modify (Изменить)  в свитке Rendering (Визуализация) 

поставьте флажок напротив Enable In Viewport (Сделать видимым в 

видовых окнах). 

Сохраните эту тренировочную сцену и потом очистите рабочую 

область. Для этого в верхнем меню выполните File > Reset(Файл > 

Сброс). 

4. Теперь необходимо разобраться в том, что не только линии, но и 

вершины сплайнов различаются по типу. Вершины сплайна 

различаются по типу и определяют степень кривизны сегментов 

сплайна, прилегающих к этим вершинам. Первая вершина, 

обозначающая начало сплайна, в момент создания помечается 

квадратиком белого цвета. В 3ds Max поддерживается четыре типа 

вершин сплайнов: 

Corner (С изломом) — вершина, в которой сплайн претерпевает излом. 

Участки сегментов вблизи такой вершины не имеют кривизны; 

Smooth (Сглаженная) — вершина, через которую кривая сплайна 

проводится с плавным изгибом, без излома, имея одинаковую кривизну 

сегментов при входе в вершину и выходе из нее; 

Bezier (Безье) — вершина, подобная сглаженной, но позволяющая 

управлять кривизной сегментов сплайна при входе в вершину и при 

выходе из нее. Для этого вершина снабжается касательными векторами 

с маркерами в виде квадратиков зеленого цвета на концах. У вершин 

типа Bezier касательные векторы всегда лежат на одной прямой, а 

удаление маркеров от вершины, которой принадлежат векторы, можно 

изменять. Перемещение одного из маркеров вершины Безье всегда 

вызывает центрально-симметричное перемещение второго. Перемещая 

маркеры касательных векторов вокруг вершины, можно изменять 

направление, под которым сегменты сплайна входят в вершину и 
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выходят из нее, а изменяя расстояние от маркеров до вершины, можно 

регулировать кривизну сегментов сплайна; 

Bezier Corner (Безье с изломом) — вершина, которая, как и вершина 

типа Bezier, снабжена касательными векторами. Однако у 

вершинBezier Corner касательные векторы не связаны друг с другом, и 

маркеры можно перемещать независимо. 

5. Чтобы в этом лучше разобраться, создайте из сплайна Line (Линия) 

исходную ломаную линию, которую вы видите на рис. 7.3. Смотрите 

готовый файл Line.max. Когда исходная линия создана, выделите ее, 

перейдите в Modify (Изменить)  и нажмите на знак «+» рядом 

с Line (Линия), а затем на Vertex (Вершина). 

 
Рис. 7.3 

Теперь выделите вершины по одной, на каждой нажмите правую 

кнопку, при этом появится контекстовое меню, фрагмент которого 

показан на рис. 7.4. Для каждой вершины выберите соответствующий 

тип. 

http://3dtuts.by/wp-content/uploads/2010/06/max7.3.gif
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Рис. 7.4 

6. Основным инструментом создания линий является 

инструмент Line (Линия). Тип каждой вершины при создании линий 

инструментом Line(Линия) определяется двумя способами. В 

свитке Creation Method (Метод создания) в 

области Initial Type (Исходный тип) определяется тип вершины, 

создаваемой простым щелчком. А в 

области Drag Type (Перетаскиваемый тип) определяется тип вершины, 

создаваемой перетаскиванием курсора мыши. При создании линий с 

угловыми вершинами образуются прямолинейные сегменты. При 

создании кривой с вершинами Безье получаются только 

криволинейные сегменты. 

Независимо от способа создания сплайна, его можно в любой момент 

преобразовать в редактируемый сплайн, за исключением кривой 

типа Line (Линия), так как она всегда находится в таком состоянии. С 

этого момента будут доступны многие полезные операции со 

сплайнами. Преобразование кривой в редактируемый сплайн может 

быть выполнено с помощью 

команды Convertto Editable Spline (Преобразовать в редактируемый 

сплайн), выбираемой из контекстного меню, появляющегося после 

щелчка правой кнопкой мыши в стеке модификаторов. 

Форма представляет собой совокупность нескольких сплайнов. Форму 

можно править на уровне ее подобъектов (вершин, сегментов, 

сплайнов) посредством преобразований перемещения, вращения и 

http://3dtuts.by/wp-content/uploads/2010/06/max7.4.gif
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масштабирования. Основной элемент сплайна – это вершина, и на этом 

уровне возможны значительные правки сплайна. 

При удалении вершины она исключается из сплайна, а на ее месте 

создается сегмент, соединяющий две соседние вершины. 

Инструмент Delete (Удалить) для удаления вершин доступен в нижней 

части свитка Geometry (Геометрия). Это же действие можно выполнить 

и с помощью клавиши <Delete> на клавиатуре компьютера. 

В отличие от удаления вершин, при объединении из двух или более 

вершин образуется одна вершина. Инструмент Weld(Объединить) для 

объединения вершин расположен в средней части 

свитка Geometry (Геометрия). Числовое поле справа определяет порог 

объединения вершин. Вершины, отстоящие друг от друга дальше, чем 

указанное пороговое значение, не объединяются. При объединении 

двух вершин на разомкнутом участке сплайна между ними образуется 

одна вершина, и сплайн замыкается. Объединяемые вершины 

предварительно должны быть выделены. При выделении вершин на 

сплайне в свитке Selection (Выбор) отображается число выделенных 

вершин. 

Чтобы добавить в сплайн новые вершины, нужно активизировать 

команду Refine (Детализировать) в верхней части 

свиткаGeometry (Геометрия), а затем в нужном месте кривой вставить 

дополнительные вершины. 

 

ТЕЛА ВРАЩЕНИЯ 

Следующая наша цель – создать из сплайна тело вращения. 

Тренироваться будем, получая рюмку. Сначала создайте исходный 

сплайн для будущей рюмки. Предлагается нечто подобное рис. 7.5. 

Создавать сплайн лучше всего на виде слева или спереди. 
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Рис. 7.5 

Теперь выделите исходный сплайн, перейдите на 

панель Modify (Изменить)  и разверните список Modifier 

List (Список модификаторов). В списке найдите 

модификатор Lathe (Тело вращения) (рис. 7.6). Сразу получится нечто 

непохожее на рюмку. Все нормально, так как пока не позиционирована 

ось вращения. 

 
Рис. 7.6 

Изменить положение оси вращения можно несколькими способами. 

Перейдите на панель Modify (Изменить)  и в 

http://3dtuts.by/wp-content/uploads/2010/06/max7.5.gif
http://3dtuts.by/wp-content/uploads/2010/06/max7.6.gif
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свитке Parameters(Параметры) меняйте выравнивание (Align) оси 

относительно сплайна (Min, Center, Max). Если все равно не 

получается, попробуйте изменить направление (Direction) оси X, Y, Z. 

Если применить выравнивание Max и ось Y, то должно получиться, как 

на рис. 7.7. 

 
Рис. 7.7 

8. Однако ось вращения можно позиционировать и произвольно. Для 

этого на панели Modify (Изменить)  нажмите знак «+» рядом 

с Lathe(Тело вращения), встаньте на Axis (Оси) (рис. 7.8). Теперь 

можно просто двигать ось вращения мышью в окнах просмотра. 

 
Рис. 7.8 

http://3dtuts.by/wp-content/uploads/2010/06/max7.7.gif
http://3dtuts.by/wp-content/uploads/2010/06/max7.8.gif
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ВЫДАВЛИВАНИЕ, ФАСКИ, ЛОФТИНГ 

Метод экструзии (Extrude), или выдавливание, удобен для 

моделирования предметов, которые имеют постоянное поперечное 

сечение вдоль одной из осей. Этот метод хорошо подходит, например, 

для моделирования деревянной мебели или создания рельефных 

текстовых надписей. 

При использовании метода экструзии так же, как и в случае метода 

вращения, необходимо сначала нарисовать двумерную форму, 

предназначенную для «выдавливания» трехмерного тела. Кривая 

формы-профиля может быть как разомкнутой, так и замкнутой. Форма 

для выдавливания может состоять из нескольких кривых. Для 

преобразования формы-профиля в тело экструзии к ней следует 

применить модификатор Extrude (Выдавливание). 

Выполните команду создания текста: Create > Shapes 

>Text (Создать > Формы > Текст). Напишите, например, слово MAX. 

Его следует набрать в окне Text (Текст) 

свитка Parameters (Параметры), а затем щелкнуть в одном из окон 

проекций, например Perspective (Перспектива). В окнах проекций 

появится набранный текст. Теперь, необходимо применить 

модификатор выдавливания (Extrude), для того чтобы сделать текст 

объемным. Для этого выделите исходный текст (сплайн), перейдите на 

панель Modify (Изменить)  и разверните список Modifier 

List (Список модификаторов). В списке 

найдите Extrude (Выдавливание). Как только вы примените этот 

модификатор, буквы в перспективной проекции станут сплошными 

(закрашенными в текущий цвет), но пока не объемными. 

Чтобы придать им объем, оставаясь на 

панели Modify (Изменить) , выделите 

модификатор Extrude (Выдавливание), хотя этот пункт, скорее всего, 

уже выделен, и в свитке Parameters (Параметры) задайте 

http://3dtuts.by/wp-content/uploads/2010/06/Modify.gif
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значение Amount (Количество). Чем большее вы задаете это значение, 

тем «объемнее» буквы. У вас должно выйти нечто подобное рис. 8.1. 

 
Рис. 8.1 

В арсенале инструментов 3ds Max имеется еще одно более 

универсальное средство, позволяющее преобразовывать двумерные 

профили в тела экструзии — это модификатор Bevel (Фаска). 

Воспользуемся им. В качестве исходного опять создадим текст, 

например BEST. Применив модификатор Bevel (Фаска), сделаем этот 

текст не просто объемным, а «объемным с фасками». Для этого 

выделите исходный текст (сплайн), опять перейдите на 

панель Modify (Изменить)  и в спискеModifier List (Список 

модификаторов) найдите модификатор Bevel (Фаска). 

Как только вы примените этот модификатор, буквы станут сплошными, 

но пока не объемными. Теперь, оставаясь на 

панелиModify (Изменить) , выделите Bevel (Фаска) и в свитке Bevel 

Values (Параметры фаски) выставьте, например, значения, как 

показано на рис. 8.2. Level 1 (Уровень 1) включен всегда, и его высота 

(Height) показывает, насколько выдавлен первый уровень. 

Значение Outline (Контур) показывает величину и направление скоса 

вдоль всего контура для этого уровня. В примере — на 15 см наружу. 

http://3dtuts.by/wp-content/uploads/2010/07/max_mod8.1.gif


38 
 

Чтобы появились уровни 2 и 3, необходимо поставить флажки в 

соответствующие окошки. 

 
Рис. 8.2 

Значения уровня 2 в примере: выдавливание составляет 15 см, 

скоса нет. Для третьего уровня: выдавливание составляет15 см и скос 

вовнутрь «-15» см. Все эти параметры даны при условии, что размер 

текста (Size) равен 240. Должно получиться что-то наподобие того, что 

показано на рис. 8.3. 

 
Рис. 8.3 

Кроме того, у объектов, созданных как выдавливанием, так и 

методом фасок, есть параметр Capping (Покрытие), в котором по 

умолчанию стоят два флажка против слов Cap Start (Закрыть в начале) 

и Cap End (Закрыть в конце) (Например, у модификатора Extrude рис. 

http://3dtuts.by/wp-content/uploads/2010/07/max_mod8.2.gif
http://3dtuts.by/wp-content/uploads/2010/07/max_mod8.3.gif
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8.4). Благодаря им  происходит заполнение букв объемом. Попробуйте 

убрать эти флажки, и буквы останутся пространственными, но пустыми 

внутри. 

 
Рис. 8.4 

 

1. Постройте параллелепипед Box01 и сферу Sphere01. Сферу 

наполовину вдвиньте в параллелепипед. Выделите Box01, перейдите на 

вкладку Create (Создать)  и из спика типов объектов 

выберите Compound Objects (Составные объекты). Активизируйте 

команду Boolean (Булева операция). Ниже нажмите кнопку Pick 

Operand B (Укажите операнд B). Если в разделе Operation (Операция) 

свитка Parameters (Параметры) помечена операция Subtraction (A-

B) (Вычитание (A-B)), то после щелчка левой кнопкой мыши по сфере 

вы получите объект, изображенный на Рис. 9.1. 

http://3dtuts.by/wp-content/uploads/2010/07/max_mod8.4.gif
http://3dtuts.by/wp-content/uploads/2010/07/Create.gif
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Рис. 9.1 

Перейдите на вкладку Modify (Изменить) . В стеке команд щелчком 

по значку «+» раскройте список Boolean (Булева операция) и щелкните 

на строке Operands (Операнды). Ниже в области Operands (Операнды) 

появятся операнды булевой операции: 

A: Box01 

B: Sphere01 

Щелкнув по любому из этих объектов (например, Sphere01), вы 

получаете доступ к редактированию параметров его положения. 

Перейдите в окно Perspective (Перспектива) и с помощью команд Select 

and Move (Выделить и перенести)  и Select and Scale (Выделить и 

масштабировать)  измените положение и размеры сферы (рис. 9.2). 

 
Рис. 9.2 

http://3dtuts.by/wp-content/uploads/2010/08/max_mod9.1.jpg
http://3dtuts.by/wp-content/uploads/2010/06/Modify.gif
http://3dtuts.by/wp-content/uploads/2010/06/Select_and_Move.gif
http://3dtuts.by/wp-content/uploads/2010/06/Select_and_Uniform_Scale.gif
http://3dtuts.by/wp-content/uploads/2010/08/max_mod9.2.jpg
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Ниже выделенной строки Operands (Операнды) появилась 

строка Sphere (Сфера). Нажмите на нее, и ниже в 

свиткеParameters (Параметры) вы получите доступ к редактированию 

всех ее параметров (рис. 9.3). 

 
Рис. 9.3 

 

1. (задание – пуговицы и иголка) Модель пуговицы. Она будет состоять 

из двух частей – сердцевины и ободка. Сердцевину создайте при 

помощи стандартного примитива Sphere (Сфера). Чтобы придать 

объекту сжатый вид, с помощью одного из вариантов команды 

масштабирования, например Select and Squash (Выделить и сжать) , 

расположенной на основной панели инструментов, масштабируйте его 

вдоль оси Z. Теперь создайте примитив Torus (Тор), который будет 

играть роль ободка. Radius 1 тора установите равным радиусу сферы. 

Выровняйте тор относительно сферы по всем трем осям. Для этого 

выделите тор, выполните команду Tools > Align > Align (Инструменты 

> Выравнивание > Выровнять) и щелкните по сфере. 

2. В окне Align Selection (Выровнять положение выделенных объектов) 

установите переключатели Current Object (Объект, положение которого 

выравнивается, — в данном случае это тор) и Target Object (Объект, 

http://3dtuts.by/wp-content/uploads/2010/08/max_mod9.3.jpg
http://3dtuts.by/wp-content/uploads/2010/08/Select_and_Squash.gif
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относительно которого происходит выравнивание, — в данногм случае 

это сфера) в положение Center (Центр) и установите флажки в полях X 

Position (по координате Х), Y Position (по координате Y), Z Position (по 

координате Z) (рис. 10.1). С помощью параметра Radius 2подберите 

ширину ободка пуговицы, а затем уточните значение параметра Radius 

1. 

 
Рис. 10.1 

3. Теперь необходимо создать четыре отверстия в сердцевине. Создайте 

объект Cylinder (Цилиндр) и установите в его настройках подходящее 

значение радиуса. Используйте инструмент Array (Массив) для 

создания остальных трех цилиндров и расположения их по вершинам 

http://3dtuts.by/wp-content/uploads/2010/08/max_mod10.1.gif
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квадрата. Для этого выполните команду Tools > Array (Инструменты > 

Массив), после чего появится окно с настройками массива (рис. 10.2). 

 
Рис. 10.2 

В области Array Dimensions (Размерность массива) установите 

переключатель в положение 2D (Двухмерный массив), и в 

поле Count (Количество) напротив переключателя введите 2. Оно будет 

определять количество рядов. В поле Count(Количество) напротив 

переключателя 1D также введите 2. Оно будет определять количество 

цилиндров в ряду. Чтобы задать положение цилиндров, установите 

некоторое значение параметра Incremental Row Offsets (Смещение 

ряда) по оси Y. Такое же значение задайте параметру, находящемуся на 

пересечении столбца X и строки Move в 

столбце Incremental (Расстояниемежду объектами) области Array 

Transformation: World Coordinates (Use Pivot Point 

Center) (Преобразование массива: глобальная система координат 

(использовать опорную точку). 

Обратите внимание, что в области Type of Object (Тип объекта) 

помечен вариант построения объектов Instance (Экземпляр). Чтобы 

иметь возможность наблюдать за изменением положения массива 

объектов в окне проекции, нажмите кнопку Preview(Предварительный 

просмотр). 

4. После использования инструмента Array (Массив) в окне проекции 

будут созданы четыре цилиндра, которые необходимо симметрично 

расположить в центре пуговицы. Для этого их сначала необходимо 

http://3dtuts.by/wp-content/uploads/2010/08/max_mod10.2.gif
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выделить и сгруппировать, выполнив командуGroup > Group (Группа > 

Группировать). Сгруппированные объекты следует выровнять 

относительно сердцевины пуговицы по центру. Для этого снова 

выполните команду Tools > Align > Align (Инструменты > 

Выравнивание > Выровнять) и согласуйте положение объектов по всем 

трем координатам. 

Поскольку со сгруппированными объектами нельзя выполнить 

операцию булева вычитания, придется вычитать цилиндры по одному, 

предварительно разгруппировав их, или объединить модели в один 

объект. Мы используем второй способ. 

5. Выделите сгруппированные объекты и выполните команду Group > 

Ungroup (Группа > Разгруппировать). Преобразуйте один из цилиндров 

в Editable Mesh (Редактируемая сетка). Для этого щелкните правой 

кнопкой мыши на объекте и выполните команду Convert To > Convert 

to Editable Mesh (Конвертировать в > Конвертировать в редактируемую 

сетку). Выделите этот цилиндр и перейдите в его настройки. В 

свитке Edit Geometry (Редактировать геометрию) нажмите 

кнопку Attach List (Список присоединяемых объектов). В появившемся 

окне выбора объектов выделите остальные три цилиндра и нажмите 

кнопку Attach(Присоединить). Вы получите единый объект. 

6. Выделите сердцевину пуговицы. Щелкните на 

кнопке Geometry (Геометрия) на вкладке Create (Создать) командной 

панели, в раскрывающемся списке выберите строку Compound 

Objects (Составные объекты) и нажмите кнопку Boolean (Булева 

операция). В области Operation (Операция) отметьте выполняемую 

операцию Subtraction (A-B) (Из A вычесть В). Щелкните на кнопке Pick 

Operand B (Укажите операнд В) и укажите объединенный объект. 

Пуговица готова (рис. 10.3). 
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Рис. 10.3 

7. Иголка. Для создания иголки в окне Perspective (Перспектива) 

воспользуйтесь примитивом Capsule (Капсула) из спискаExtended 

Primitives (Дополнительные примитивы). Чтобы этот примитив был 

похож на иголку, в его настройках необходимо выбрать большое 

значение параметра Height (Высота) и очень маленькую величину 

параметра Radius. 

8. Ушко иголки сделайте с помощью булевой операции вычитания. 

Сначала создайте объект, который будет вычитаться из иголки. Этим 

объектом может быть тот же примитив Capsule (Капсула). Для этого 

выполните команду Edit > Clone(Редактирование > Клон), чтобы 

создать копию капсулы с типом клонирования Copy (Копия). 

Уменьшите значение параметраHeight (Высота) до величины 

игольного ушка и приподнимите объект на необходимую высоту вдоль 

оси Z. Используйте операцию масштабирования для сжатия объекта 

вдоль оси X и растяжения вдоль оси Y поочередно, причем вдоль одной 

из осей масштабируйте в большую сторону, а вдоль другой – в 

меньшую. 

9. Объекты готовы для выполнения булевой операции вычитания (рис. 

10.4). 

http://3dtuts.by/wp-content/uploads/2010/08/max_mod10.3.gif
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Рис. 10.4 

Выделите иголку и в свитке Compound Objects (Составные объекты) 

нажмите кнопку Boolean (Булева операция). В настройках булевого 

объекта нажмите кнопку Pick Operand B (Укажите операнд В) и 

укажите второй объект. У иголки появится ушко (рис. 10.5). 

 
Рис. 10.5 

10. Чтобы объект был похож на иголку, с одной стороны его 

необходимо заострить. Сделать это можно с помощью 

модификатора Taper (Сужение). Примените к объекту этот 

http://3dtuts.by/wp-content/uploads/2010/08/max_mod10.4.gif
http://3dtuts.by/wp-content/uploads/2010/08/max_mod10.5.gif
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модификатор. В его настройках уменьшите значение 

параметраAmount (Количество), в данном случае в отрицательную 

сторону. Иголка готова. 

11. Катушка с нитками. Создайте в окне Perspective (Перспектива) 

объект ChamferCyl (Цилиндр с фаской), выбрав его из списка Extended 

Primitives (Дополнительные примитивы). В его настройках увеличьте 

значение параметра Fillet(Закругление), чтобы сгладить острые углы по 

краям объекта. Увеличьте величину Fillet Segs (Число сегментов на 

скруглении), чтобы получить более гладкую поверхность края объекта. 

Создайте примитив Tube (Труба), выбрав его из списка Standard 

Primitives (Стандартные примитивы). Мы будем использовать его для 

выполнения булевой операции. Значение параметра Radius 1 в 

настройках примитива Tube (Труба) необходимо установить меньшим, 

чем значение параметра Radius в настройках цилиндра. Величина 

параметра Radius 2 трубки должна быть больше значения 

параметра Radius цилиндра. Высота объекта Tube (Труба) должна быть 

меньше высоты цилиндра. 

12. Теперь необходимо выровнять объекты относительно друг друга по 

всем трем координатам в области Align Position(Выровнять положение 

по координатам). Выделите первый объект и выполните 

команду Tools > Align > Align (Инструменты > Выравнивание > 

Выровнять). Затем укажите второй объект. Появится окно Align 

Selection (Выровнять положение выделенных объектов). Установите в 

нем переключатели Current Object (Объект, положение которого 

выравнивается) и Target Object(Объект, относительно которого 

происходит выравнивание) в положение Center (Центр) (рис. 10.6). 
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Рис. 10.6 

Теперь можно произвести булеву операцию вычитания. 

Выделите ChamferCyl (Цилиндр с фаской) и нажмите 

кнопку Boolean(Булева операция). В настройках булева объекта 

нажмите кнопку Pick Operand B (Укажите операнд В) и укажите 

примитивTube (Труба). Получится катушка (рис. 10.7). 

 
Рис. 10.7 

13.Для создания мотка ниток на катушке можно использовать 

примитив ChamferCyl (Цилиндр с фаской) меньшего радиуса, который 

нужно выровнять относительно катушки. Для большей реалистичности 

можно добавить свисающую нить, создав ее при помощи сплайна (рис. 

10.8). Чтобы сплайн отображался в процессе визуализации, в 

http://3dtuts.by/wp-content/uploads/2010/08/max_mod10.6.gif
http://3dtuts.by/wp-content/uploads/2010/08/max_mod10.7.gif
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свитке Rendering (Визуализация) его настроек установите 

флажок Enable In Renderer (Показать при визуализации). 

 
Рис. 10.8 

Урок для версии 3dsMax 2009. 

1. Благодаря объекту типа Scatter (Распределенный) можно размещать 

по поверхности одного объекта другие объекты. Так можно создавать 

поляны с травой, деревья с листьями, парки и т.д. Объект 

типа Scatter (Распределенный) находится в разделе Compound 

Objects (Составные объекты). Сначала создаем объект, на поверхности 

которого будут размещаться другие объекты, 

например Box (Параллелепипед) с текстурой. Текстуру можно 

наложить на объект следующим образом. Нажмите клавишу <M> (в 

латинской раскладке клавиатуры), появится диалоговое окно Material 

Editor (Редактор материалов). Щелкните на 

кнопке Standard (Стандартный), откроется диалоговое 

окно Material/Map Browser (Браузер материалов и текстурных карт), в 

нем слева вверху отметьте Mtl Library (Библиотека материалов). 

Найдите в списке материал Ground Foliage (Standard), затем OK. Если 

его там не окажется, то в том же окне выполните File > Open (Файл > 

Открыть), а затем найдите на вашем компьютере файл с библиотекой 

http://3dtuts.by/wp-content/uploads/2010/08/max_mod10.8.jpg
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материалов, поставляемых совместно с 3ds Max. Для этого войдите в 

корневой каталог используемой вами системы 3ds Max, откройте 

папку materiallibraries (в системе, отличной от 3ds Max 2009, 

расположение списка материалов может быть иным) и выберите 

материал 3dsmax.mat; в окне Material/Map Browser (Браузер материалов 

и текстурных карт) появится длинный список материалов, среди 

которых будет материал Ground Foliage (Standard).  

Выделите объект Box (Параллелепипед), в окне редактора материалов 

щелкните на кнопке  Assign Material to Selection(Назначить материал 

выделенным объектам) , после чего щелкните на кнопке Show Map 

in Viewport (Показать текстурную карту в видовом окне) . 

Материал отобразится на объекте. 

 

СОСТАВНЫЕ ОБЪЕКТЫ 

В любом месте создайте объект, который будет распределяться по 

поверхности, например гриб (рис. 11.1). Создать гриб можно из 

примитивов: шляпку из сферы и ножку из 

примитива Capsule (Капсула). При создании сферы воспользуйтесь 

опцией Slice On (Обрезать) и установите значение параметра Slice 

To (Обрезать до) равным 180. При создании ножки из 

примитиваCapsule (Капсула) тяните ее снизу вверх. Тогда система 

координат ножки останется у ее основания. Этим местом гриб ляжет на 

поляну. Затем войдите на вкладку Modify (Изменить)  и задайте 

достаточное число сегментов по высоте ножки (Height Segs), 

например 16. Это понадобится нам для выделения части ножки гриба 

при ее раскраске. Чтобы ножка гриба внизу была потолще, выделите 

ее, раскройте список модификаторов и примените к ножке 

модификатор Taper (Сужение) с соответствующим значением 

параметра Amount (Количество), например, -0,6. 

http://3dtuts.by/wp-content/uploads/2010/09/Assign_Material_to_Selection.gif
http://3dtuts.by/wp-content/uploads/2010/10/Show_Map_in_Viewport.gif
http://3dtuts.by/wp-content/uploads/2010/06/Modify.gif
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Рис. 11.1 

В конечном счете, шляпка и ножка гриба должны представлять собой 

единый булевый объект. Чтобы вспомнить, как создаются булевы 

объекты, обратитесь к предыдущим упражнениям. Еще раз обратите 

внимание, где у полученного гриба расположена система координат, 

она должна быть внизу. Поэтому при выполнении булевого 

объединения ножки со шляпкой с помощью 

операции Union (Объединение) сперва выделите ножку, а затем к ней 

присоедините шляпку. После этого конвертируйте модель гриба 

в Editable Poly (Редактируемые полигоны), щелкнув на ней правой 

кнопкой мыши и выбрав команду Convert To > Convert to Editable 

Poly (Конвертировать в > Конвертировать в редактируемые полигоны). 

Это пригодится нам для раскраски гриба. 

3. Теперь снова щелкните на клавиатуре на клавише <M> и раскройте 

окно Material Editor (Редактор материалов). Выберите любую 

свободную ячейку в верхней части окна. Затем назначьте ей нужный 

цвет для шляпки гриба. Для этого щелкните на прямоугольнике 

напротив Ambient (Фоновое освещение), откроется 

окно Color Selector (Назначение параметров цвета), установите 

желаемый цвет. Теперь выберите следующую свободную ячейку и 

задайте другой цвет – для ножки гриба. 

На следующем шаге необходимо присвоить подготовленные цвета 

заранее выбранным полигонам. Выделите объект, раскройте 

строку Editable Poly (Редактируемые полигоны), нажав рядом с ней на 

http://3dtuts.by/wp-content/uploads/2010/10/max_mod11.2.gif
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плюсик, и перейдите в строку Polygon (Полигон). Теперь в окне 

проекций выделите полигоны относящиеся к шляпке гриба, а затем 

присвойте им соответствующий цвет. Для этого в 

окне Material Editor (Редактор материалов) выделите ячейку с нужным 

цветом, а затем ниже щелкните на 

кнопкеAssign Material to Selection (Назначить материал выделенным 

объектам) . Чтобы увидеть окрашенные полигоны в окне проекций, 

щелкните правее на кнопке Show Map in Viewport (Показать 

текстурную карту в видовом окне). Повторите эту процедуру для 

ножки гриба. Раскраска гриба закончена. 

4. Когда гриб готов, выделите его, перейдите на 

вкладку Create (Создать)  тип Geometry (Геометрия)  выберите 

из списка Compound Objects (Составные 

объекты)  Scatter (Распределенный) и в 

свитке Scatter Objects (Разбрасываемые объекты) назначьте вариант 

построения Use Distribution Object (Использовать объект, на котором 

будет осуществлено распределение). 

Далее нужно выбрать объект, на котором гриб будет распределяться. 

Для этого нажмите на Pick Distribution Object (Укажите объект, на 

котором будет осуществлено распределение) (рис. 11.2) и выберите 

параллелепипед. 

http://3dtuts.by/wp-content/uploads/2010/09/Assign_Material_to_Selection.gif
http://3dtuts.by/wp-content/uploads/2010/07/Create.gif
http://3dtuts.by/wp-content/uploads/2010/07/Geometry.gif


53 
 

 
Рис. 11.2 

Снимите флажок напротив Perpendicular (Перпендикулярно) в 

разделе Distribution Object Parameters (Параметры размещения 

дубликатов на базовой поверхности). Тогда гриб сохранит свою 

первоначальную ориентацию (рис. 11.3). 

 
Рис. 11.3 

5. Теперь можно увеличить количество грибов через параметр 

объекта Duplicates (Дубликаты) (рис. 11.4), а затем масштабировать их 

http://3dtuts.by/wp-content/uploads/2010/10/max_mod11.1.gif
http://3dtuts.by/wp-content/uploads/2010/10/max_mod11.3.jpg
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с помощью параметра Base Scale (Масштаб). Можно несколько 

разнообразить вид дубликатов, изменяя хаотичность их вершин, для 

этого воспользуйтесь параметром Vertex Chaos (Хаотичность вершин 

дубликатов). 

 
Рис. 11.4 

6. Вариант распределения дубликатов объекта по поверхности базового 

объекта можно задать, установив переключательDistribute 

Using (Метод распределения) в одно из следующих положений: 

Аrеа – равномерное случайное распределение дубликатов на всей 

базовой поверхности; 

Even (Равномерно) — число граней объекта-базы делится на 

количество дубликатов; при размещении дубликатов необходимое 

число граней пропускается; 

Skip N (Пропуская N граней) — при распределении дубликатов будет 

пропускаться N граней базового объекта, где N — число, указанное в 

счетчике справа от переключателя; 

http://3dtuts.by/wp-content/uploads/2010/10/max_mod11.4.gif
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Random Faces (Случайные грани) — дубликаты распределяются 

случайным образом; 

Along Edges (Вдоль ребер) — дубликаты случайным образом 

распределяются вдоль ребер базового объекта; 

All vertices (Во всех вершинах) — дубликаты помещаются в каждую 

вершину базового объекта, при этом заданное число дубликатов 

игнорируется; 

All edge midpoints (В серединах всех ребер) — дубликаты помещаются 

в середине всех ребер базового объекта; 

All faces centers (По центрам всех граней) — дубликаты помещаются в 

центре всех граней базового объекта; 

Volume (По объему) — в отличие от всех предыдущих вариантов, в 

которых распределение происходит по поверхности базового объекта, 

в данном случае дубликаты распределяются в пределах всего объема 

этого объекта. 

Результат распределения грибов на поляне показан на рис. 11.5. 

 
Рис. 11.5 

7. Внизу свитка Distribution Object Parameters (Параметры размещения 

дубликатов на базовой поверхности) установите 

переключатель Display (Отображение) в одно из двух 

http://3dtuts.by/wp-content/uploads/2010/11/max_mod11.5.jpg
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положений: Result (Результат) — будут демонстрироваться результаты 

распределения дубликатов, а Operands (Операнды) — будут 

показываться только распределяемый объект и базовый объект. 

Чтобы придать случайный характер не только распределению 

дубликатов в пределах базового объекта, но и преобразованиям самих 

дубликатов, используйте элементы управления 

свитка Transforms (Трансформации), показанного на рис. 11.6. 

 
Рис. 11.6 

8. Задайте пределы случайных изменений параметров поворота 

дубликатов в счетчиках X, Y, Z раздела Rotation, (Вращение), а 

смещения вдоль локальных осей координат дубликатов можно задать в 

аналогичных счетчиках раздела Local Translation(Локальное 

смещение). Смещения в пределах граней базового объекта задайте в 

разделе Translation on Face (Сдвиг в пределах грани) и масштаба — в 

разделе Scaling (Масштабирование). Флажки Use Maximum 

Range (Использовать максимальный диапазон) обеспечивают 

http://3dtuts.by/wp-content/uploads/2010/11/max_mod11.6.gif
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использование наибольших пределов распределения из указанных в 

счетчиках преобразований по осям X, Y, Z. Установка флажка Lock 

Aspect Ratio (Сохранить соотношение геометрических размеров) 

обеспечивает сохранение пропорций дубликатов при 

масштабировании. 

9. В свитке Display (Отображение) можно установить 

переключатель Proxy (Приближенное), чтобы в видовых окнах для 

ускорения прорисовки вместо самих дубликатов отображались их 

приближенные макеты, или переключатель Mesh (Сеточная модель) 

для точного отображения дубликатов (рис. 11.7). В 

счетчике Display (Отображение) можно задать долю общего количества 

дубликатов, которая будет отображаться в окнах проекций. Чтобы 

скрыть базу распределений, установите флажокHide Distribution 

Object (Скрыть базовый объект). Там же имеется кнопка New (Новый). 

Нажав ее, получите новый вариант размещения грибов на поляне. 

 
Рис. 11.7 

http://3dtuts.by/wp-content/uploads/2010/11/max_mod11.7.gif
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10. Объекты типа Scatter (Распределенный) имеют достаточно много 

параметров. Поэтому, однажды выполнив их настройку, можно с 

помощью свитка Load/Save Presets (Загрузить/Сохранить 

предварительные настройки) сохранить всю совокупность значений 

для последующего повторного использования применительно к иначе 

распределенному объекту. Для сохранения совокупности значений 

параметров введите имя в поле Preset Name (Имя предварительных 

настроек) и там же щелкните на кнопке Save (Сохранить). Для загрузки 

ранее сохраненного набора параметров выделите имя заготовки в 

списке Saved Presets(Сохраненные настройки) и щелкните на 

кнопке Load (Загрузить).  Щелчок на кнопке Delete (Удалить) позволяет 

удалить заготовку, имя которой выбрано в списке Saved 

Presets (Сохраненные настройки). 

 

 

ТЕКСТУРИРОВАНИЕ ПРОСТОЙ СЦЕНЫ 

В этом уроке мы предлагаем вам подобрать текстуры для простой сцены с 

посудой, примерно такой, с которой мы работали во второй главе.  

Как вы можете видеть (рис. 5.16), эта сцена состоит из нескольких объектов: 

чашки, полки для посуды, тарелок и подставки для них. Ко всем этим 

объектам применен тип материала Standard (Стандартный).  

Если вы сейчас нажмете кнопку F9 и визуализируете сцену, вы увидите, что 

полученное изображение практически не отличается от того, которое вы 

видите в окнах проекций.  

Чтобы придать сцене реалистичность, текстурируем ее.  
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Рис. 5.16. Сцена до текстурирования 

Сначала определимся с материалами. Прежде чем приступать к их созданию, 

нужно продумать, как должны выглядеть объекты. 

Предположим, что полка будет сделана из дерева, подставки для тарелок 

будут металлические, тарелки — фарфоровые, а чашка — стеклянной.  

Таким образом, нужно создать четыре разных материала.  

Материал для полки 

Откройте окно Material Editor (Редактор материалов), выполнив 

команду Rendering > Material Editor (Визуализация > Редактор материалов) 

или нажав клавишу М, и в пустой ячейке создайте новый материал на 

основе Standard (Стандартный). 

Он установлен по умолчанию, в чем можно убедиться, посмотрев на кнопку 

выбора материала.  

На ней обозначено название материала Standard (Стандартный). Установите 

для материала тип тендера Blinn (По Блинну).  

В свитке настроек Shader Basic Parameters (Основные параметры затенения) 

установите флажок 2-Sided (Двухсторонний), чтобы материал был 

двухсторонним (рис. 5.17).  
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Рис. 5.17. Настройки материала для полки 

Перейдите к свитку Maps (Карты) настроек материала и в качестве 

карты Diffuse Color (Цвет рассеивания) выберите Bitmap (Растровое 

изображение). Для этого сделайте следующее.  

1. Нажмите кнопку None (He назначена) возле строки Diffuse Color (Цвет 

рассеивания).  

2. В появившемся окне Material/Map Browser (Окно выбора материалов и 

карт) дважды щелкните на строке Bitmap (Растровое изображение) (рис. 5.18). 
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Рис. 5.18. Выбор карты Bitmap (Растровое изображение) в окне Material/Map 

Browser (Окно выбора материалов и карт) 

В появившемся окне Select Bitmap Image File (Выбрать растровое 

изображение) укажите путь к файлу CEDFENCE. jpg (рис. 5.19).  

Этот файл входит в стандартную поставку текстур 3ds max 7 и по умолчанию 

располагается по адресу Диск:\3dsmax7\maps\Wood\CEDFENCE.jpg.  

В настройках этой карты установите значение параметра Tiling 

U (Повторяемость по координате U) равным 3,7 (рис. 5.20).  

 
Рис. 5.19. Окно Select Bitmap Image File (Выбрать растровое изображение) 
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Рис. 5.20. Настройки процедурной карты Bitmap (Растровое изображение) 

Теперь необходимо вернуться к настройкам основного материала.  

Для этого раскройте список с названиями материалов и карт и выберите 

верхнюю строку (рис. 5.21).  

 
Рис. 5.21. Переход к настройкам основного материала 

Перейдите к свитку Maps (Карты) настроек материала и в качестве 

карты Bump (Рельеф) выберите Bitmap (Растровое изображение) так, как это 

описано выше.  
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В появившемся окне Select Bitmap Image File (Выбрать растровое 

изображение) снова укажите путь к файлу CEDFENCE. jpg.  

В настройках этой карты установите значение параметра Tiling 

U (Повторяемость по координате U) равным 3,7.  

Вернитесь в настройки основного материала так, как это описано выше, и 

установите значение параметра, определяющего степень влияния 

карты Bump(Рельеф) на материал, равным 10 (рис. 5.22).  

 
Рис. 5.22. Установка степени влияния карты на основной материал 

На этом создание материала для полки завершено. Нажав и удерживая 

клавишу Ctrl, выделите в окне проекции объекты полки, убедитесь, что 

в Material Editor (Редактор материалов) выбран созданный вами материал, и 

щелкните на кнопке Assign Material to Selection (Назначить материал 

выделенным объектам) на панели инструментов окна Material 

Editor (Редактор материалов) (см. рис. 5.4).  

Вы сможете визуально определить, что материал назначен объектам, так как 

в его ячейке по углам появятся скосы.  

Нажмите кнопку F9, чтобы визуализировать сцену.  

На визуализированном изображении можно будет увидеть, что полка 

текстурирована (рис. 5.23).  
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Рис. 5.23. Визуализированная сцена с материалом для полки 

Материал для тарелок 

Откройте окно Material Editor (Редактор материалов), выполнив 

команду Rendering > Material Editor (Визуализация > Редактор материалов) 

или нажав клавишу М, и в пустой ячейке создайте новый материал 

типа Raytrace (Трассировка).  

По умолчанию установлен тип материала Standard (Стандартный).  

Чтобы изменить его, нажмите кнопку выбора материала (рис. 5.24) и в 

окне Material/Map Browser (Окно выбора материалов и карт) дважды 

щелкните на типе материала Raytrace (Трассировка) (рис. 5.25).  

 
Рис. 5.24. Кнопка выбора материала в окне Material Editor (Редактор 

материалов) 
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Перейдите к свитку Maps (Карты) настроек материала и в качестве 

карты Reflect (Отражение) выберите процедурную карту Falloff (Спад) так, 

как это описано выше.  

 
Рис. 5.25. Выбор типа материала Raytrace (Трассировка) в окне Material/Map 

Browser (Окно выбора материалов и карт) 

При этом вы автоматически переключитесь в настройки карты Falloff (Спад). 

Для нее из списка Falloff Type (Тип спада) в свитке Falloff 

Parameters(Параметры спада) выберите тип затухания Fresnel (По Френелю) 

(рис. 5.26). Используя список с названиями материалов и карт, перейдите в 

настройки основного материала. В свитке Raytrace Basic 

Parameters (Основные параметры трассировки) установите значение 

параметра Specular Level (Уровень блеска) равным 250, a Glossiness (Глянец) 
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— 80. Выберите белый цвет для параметра Diffuse (Рассеивание). Для этого 

нажмите кнопку цвета рядом с названием этого параметра и в окне Color 

Selector: Diffuse (Выбор цвета: рассеивание) выберите следующие 

значения: Red (Красный) — 248, Green(Зеленый) — 249, Blue (Синий) — 253 

(рис. 5.27). Установите в свитке Raytrace Basic Parameters (Основные 

параметры трассировки) настроек основного материала значение 

параметра Index of Refr. (Индекс преломления) равным 0,6 (рис. 5.28).  

 
Рис. 5.26. Настройки процедурной карты Falloff (Спад) 

 
Рис. 5.27. Окно Color Selector: Diffuse (Выбор цвета: рассеивание) 
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На этом создание материала для тарелок можно считать завершенным. Нажав 

и удерживая клавишу Ctrl, выделите тарелки в окне проекции, затем 

убедитесь, что в Material Editor (Редактор материалов) выбран созданный 

вами материал, после чего щелкните на кнопке Assign Material to 

Selection(Назначить материал выделенным объектам) на панели 

инструментов окна Material Editor (Редактор материалов) (см. рис. 5.4).  

Вы сможете визуально определить, что материал назначен объектам, так как 

в его ячейке по углам появятся скосы. Нажмите клавишу F9, чтобы 

визуализировать сцену. На визуализированном изображении можно будет 

увидеть, что теперь в сцене текстурированы тарелки (рис. 5.29).  

 
Рис. 5.28. Настройки материала Raytrace (Трассировка) 
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Рис. 5.29. Визуализированная сцена с материалом для полки и тарелок 

Материал для подставок 

Откройте окно Material Editor (Редактор материалов), выполнив 

команду Rendering > Material Editor (Визуализация > Редактор материалов) 

или нажав клавишу М, и в пустой ячейке создайте новый материал на 

основе Standard (Стандартный). Он установлен по умолчанию, в чем можно 

убедиться, посмотрев на кнопку выбора материала. На ней обозначено 

название материала Standard (Стандартный).  

Установите для материала тип затенения Metal (Металл). Он сделает 

выбранный тип материала более похожим на металлический. В свитке 

настроек Metal Basic Parameters (Основные параметры металла) выберите 

желтый цвет для параметра Diffuse (Рассеивание). Для этого нажмите кнопку 

цвета рядом с названием этого параметра и в окне Color Selector: 

Diffuse (Выбор цвета: рассеивание) задайте следующие 

значения: Red (Красный) — 227, Green(Зеленый) — 255, Blue (Синий) — 150. 

Установите значение параметра Specular Level (Уровень блеска) равным 173, 

a Glossiness (Глянец) — 20 (рис. 5.30).  
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Рис. 5.30. Настройки материала для подставок 

На этом создание материала для подставок можно считать завершенным. 

Нажав и удерживая клавишу Ctrl, выделите подставки для тарелок в окне 

проекции, убедитесь, что в Material Editor (Редактор материалов) выбран 

созданный вами материал, и щелкните на кнопке Assign Material to 

Selection(Назначить материал выделенным объектам) на панели 

инструментов окна Material Editor (Редактор материалов) (см. рис. 5.4).  

 

Вы сможете визуально определить, что материал назначен объектам, так как 

в его ячейке по углам появятся скосы. Нажмите клавишу F9, чтобы 

визуализировать сцену. На визуализированном изображении можно будет 

увидеть, что подставка текстурирована (рис. 5.31).  
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Рис. 5.31. Визуализированная сцена с материалом для полки, тарелок и 

подставок 

Материал для чашки 

Откройте окно Material Editor (Редактор материалов), выполнив 

команду Rendering > Material Editor (Визуализация > Редактор материалов) 

или нажав клавишу М, и в пустой ячейке создайте новый материал 

типа Raytrace (Трассировка). По умолчанию установлен тип 

материала Standard (Стандартный). Чтобы изменить его, нажмите кнопку 

выбора материала (см. рис. 5.24) и в окне Material/Map Browser (Окно выбора 

материалов и карт) дважды щелкните на типе 

материала Raytrace (Трассировка) (см. рис. 5.25). Перейдите к 

свитку Maps (Карты) настроек материала и в качестве 

карты Reflect(Отражение) выберите процедурную карту Falloff (Спад) так, как 

это описано выше.  

При этом вы автоматически переключитесь в настройки карты Falloff (Спад). 

Из списка Falloff Type (Тип спада) в свитке Falloff Parameters (Параметры 

спада) выберите тип затухания Fresnel (По Френелю) (см. рис. 5.26).  
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Используя список с названиями материалов и карт, перейдите в настройки 

основного материала. В свитке настроек Maps (Карты) установите значение 

параметра Amount (Величина), определяющее степень влияния на материал 

карты Reflect (Отражение), равным 50 (рис. 5.32).  

 
Рис. 5.32. Установка степени влияния карты на основной материал 

В свитке Raytrace Basic Parameters (Основные параметры трассировки) 

установите значение параметра Specular Level (Уровень блеска) равным 

250,Glossiness (Глянец) — 80, a Index of Refr. (Индекс преломления) равным 

1,5 (рис. 5.33).  

 
Рис. 5.33. Настройки материала Raytrace (Трассировка) 

Выберите белый цвет для Diffuse (Рассеивание). Для этого нажмите кнопку 

цвета рядом с названием этого параметра и в окне Color Selector: 
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Diffuse(Выбор цвета: рассеивание) выберите такие значения: Red (Красный) 

— 220, Green (Зеленый) — 221, Blue (Синий) — 221. Чтобы сделать стекло 

прозрачным, выберите белый цвет для Transparency (Прозрачность). Для 

этого нажмите кнопку цвета рядом с названием этого параметра и в окне Color 

Selector: Transparency (Выбор цвета: прозрачность) установите следующие 

значения: Red (Красный) — 255, Green (Зеленый) — 255, Blue (Синий) - 255 

(рис. 5.34).  

Убедитесь, что выделена ячейка созданного вами материала, и перетащите 

его на чашку в окне проекции. Вы сможете визуально определить, что 

материал назначен объекту, так как в его ячейке по углам появятся скосы. 

Нажмите клавишу F9, чтобы визуализировать сцену. На визуализированном 

изображении можно будет увидеть, что теперь чашка текстурирована (рис. 

5.35).  

 
Рис. 5.34. Окно Color Selector: Transparency (Выбор цвета: прозрачность) 

 
Рис. 5.35. Визуализированная сцена с материалами для всех объектов 


